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How to play

The object of the game is simple.    Turn off all the lights in the shortest amount of time.    The board 
consists of a set of lighted buttons.    Each lighted button can be in one of two states - illuminated (on) or 
not illuminated (off).    The buttons are pressed by using the left mouse button, or by using the arrow keys 
and the space bar.    Each lighted button, when pressed, will toggle the state of a fixed set of one or more 
lights.    For example, if the first button, when pressed, toggles the 4th and 5th buttons and the current 
state of the 4th button is “on” and the current state of the 5th button is “off”, pressing the first button would
result in the 4th button changing to the “off” state and the 5th button changing to the “on” state.    If you 
would like to see how this works, press a button repeatedly on the playing board and you will see a 
particular set of lights change state.

Playing strategy tip

It is sometimes helpful to choose a light on the board and find all the buttons that will 
change the state of that light.    Then press those buttons in a way that turns that light off.



Game menu commands

The Game menu offers the following commands:

New Starts a new game.
Exit Exits Turn Those Lights Off!.



Exit command (Game menu)

Use this command to exit the game.



Skill level

The Skill level selected determines the size of the playing grid and the number of light 
combinations for each button:

Level 1 4 by 4 grid.    1 light per button The easiest level.
Level 2 5 by 5 grid.    1 light per button
Level 3 4 by 4 grid.    Up to 2 lights per 

button.
Level 4 5 by 5 grid.    Up to 2 lights per 

button.
Level 5 4 by 4 grid.    Up to 3 lights per 

button.
Level 6 5 by 5 grid.    Up to 3 lights per 

button.
The most difficult level.



Hint

This button is only available after you register this software.

Use the hint button to show a button that needs to be pressed.    The button to be pressed 
will appear shaded.

Use the hint button with care.    For every hint that you receive, a 10 second penalty is added
to your time.



Options menu commands

The Options menu offers the following commands:

Button 
Color. . .

Use this command to change the colors of the buttons.

Music Use this command to toggle the music on or off.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Best Times Shows the best times for all the skill levels.
Wrenware Home Page If you have an Internet browser, this command 

will launch the browser and view the Wrenware 
home page.

Wrenware Home Page

If you have an Internet browser installed, use this command to view the Wrenware home 
page.    The Wrenware home page contains the latest information on new and updated 
Wrenware products.



Best Times command (View menu)

Use this command to view the best times for all the skill levels.



Best Times dialog

This dialog shows the best times for all the skill levels.



New Record dialog

This dialog appears when you break the standing record for the best time.



Your Time dialog

This dialog shows the time that it took to complete the puzzle.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you 
can get help.

About Displays the version number of this 
application.

New command (Game menu)

Use this command to start a new game in Turn Those Lights Off!.

Shortcuts
Keys: CTRL+N



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Turn Those Lights Off!, such as Game New.    A check mark 
appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Turn Those Lights Off!™,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Turn Those Lights Off!™ window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right area of the status bar indicates the time elapsed.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Turn Those Lights Off!™ and various types of 
reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Turn 
Those Lights Off!.



Context Help command 

Use the Context Help command to obtain help on some portion of Turn Those Lights Off!.    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Then click somewhere in the Turn Those Lights Off! window, such
as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Turn Those Lights Off!™ window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the Game menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the game window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Color dialog box

Use this dialog to change the color of the lighted buttons.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Registration
Turn Those Lights Off! 2.0

Registration

You may purchase the registered version of this software over the Internet.    Visit the 
Wrenware site http://wrenware.com for details.

A benefit for registering this software is the Hint Button.

Special Registrations

To purchase a site-license or make any other special arrangements, contact:

Wrenware
PMB 802
15600 NE 8th ST
Suite B1
Bellevue, Washington 98008-3900
USA
Email:    info@wrenware.com

Internet: http://wrenware.com



Copyright/License/Warranty

Copyright © 1996-1999 Wrenware™
All rights reserved.

License Agreement
You should carefully read the following terms and conditions before using this software.    
Unless you have a different license agreement signed by Wrenware, your use of this 
software indicates your acceptance of this license agreement and warranty.

Unregistered Version
Evaluation and Registration
This is not free software.    You are hereby licensed to use this software for evaluation 
purposes without charge for a period of 30 days.    If you use this software after the 30-day 
evaluation period, you are required to register this software.

Unregistered use of Turn Those Lights Off! after the 30-day evaluation period is in violation 
of U.S. and international copyright laws.

Distribution
You are hereby licensed to make as many copies of the unregistered version of this 

software and documentation as you wish; give exact copies of the original unregistered 
version to anyone; and distribute the unregistered version of the software and 
documentation in its unmodified form via electronic means.

There is no charge for any of the above.

Disk Vendors, Shareware Distributors and BBS(s) may charge a nominal fee for 
distribution of “Turn Those Lights Off!”. The recipient of “Turn Those Lights Off!” must be 
informed, in advance, that the fee paid to acquire the software does not relieve the recipient
from registering the software, if the recipient continues to use “Turn Those Lights Off!”.

Registered Version
One registered copy of Turn Those Lights Off! may either be used by a single person who 
uses the software personally on one or more computers, or installed on a single workstation 
used non-simultaneously by multiple people, but not both.    You may access the registered 
version Turn Those Lights Off! through a network, provided that you have obtained individual
licenses, or a site license, for the software covering all workstations that will access the 
software through the network.

LIMITED WARRANTY AND DISCLAIMER OF WARRANTY 
 

THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING 



INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND.
FURTHERMORE, WRENWARE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE 
SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 
RELIABILITY, CURRENTNESS, OR OTHERWISE.    THE ENTIRE RISK AS TO THE 
RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU.    IF THE 
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU, AND NOT WRENWARE OR
ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, THAT IS MADE BY 
WRENWARE, ON THIS WRENWARE PRODUCT.    NO ORAL OR WRITTEN INFORMATION 
OR ADVICE GIVEN BY WRENWARE, ITS DEALERS, DISTRIBUTORS, AGENTS OR 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.    
YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

NEITHER WRENWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE 
CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY
DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING 
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO 
USE SUCH PRODUCT, EVEN IF WRENWARE HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.
 
Governing Law

This Limited Warranty shall be governed and construed in accordance with the 
laws of the State of Washington.

ACKNOWLEDGMENT

BY USING TURN THOSE LIGHTS OFF!, YOU ACKNOWLEDGE THAT YOU HAVE READ 
THIS LIMITED WARRANTY, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS' 
TERMS AND CONDITIONS.    YOU ALSO AGREE THAT THE LIMITED WARRANTY IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND
SUPERSEDE ALL PROPOSALS OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY 
OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT 
MATTER OF THE LIMITED WARRANTY.



Support

Unlimited support for this product can be obtained by the following means:

U.S. Mail
Wrenware
PMB 802
15600 NE 8th ST
Suite B1
Bellevue, Washington 98008-3900

Electronic Mail
support@wrenware.com

Wrenware Home Page
http://wrenware.com

All problem reports and suggestions are welcome.



Definition of Shareware
Shareware distribution gives users a chance to try software before buying it.    If you try a 
Shareware program and continue using it, you are required to register it.

Copyright laws apply to both Shareware and retail software, and the copyright holder retains
all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like retail authors, and the programs are of comparable 
quality. (In both cases, there are good programs and bad ones!) The main difference is in the
method of distribution. The author specifically grants the right to copy and distribute the 
software, either to all and sundry or to a specific group. For example, some authors require 
written permission before a commercial disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's retail or Shareware. The Shareware system 
makes fitting your needs easier, because you can try before you buy. And because the 
overhead is lower, prices are lower also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.

ASP Ombudsman Policy

This program is produced by a member of the Association of Shareware 
Professionals (ASP). ASP wants to make sure that the shareware principle 
works for you. If you are unable to resolve a shareware-related problem 
with an ASP member by contacting the member directly, ASP may be able 
to help. The ASP Ombudsman can help you resolve a dispute or problem 
with an ASP member, but does not provide technical support for members' 
products. Please write to the ASP Ombudsman at 157-F Love Ave, 
Greenwood, IN 46142 USA, FAX 317-888-2195, or send email to omb@asp-
shareware.org.



Uninstalling
Turn Those Lights Off! can be uninstalled as follows:

· From the "Settings" menu under the "Start button”, choose the "Control Panel".

· From within the "Control Panel", choose "Add/Remove Programs".

· Select "Turn Those Lights Off!" and then press the "Add/Remove" button.




